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 Electronic Voice Phenomena  
Otherwise known as E.V.P.  

  
Written by: Todd M. Bates  
Founder of Haunted Voices  

  
  

The mystery of Electronic Voice Phenomena has been around for many years.  There 
are quite a few paranormal investigators out there that refuse to work with the phenomena due 
to its complications. I personally feel that it is very much worth the extra effort.   

E.V.P. is a great communication tool for the other side and the phenomena itself can 
answer some of the questions that we have all asked ourselves over the years.  Simply put, it 
just makes sense to experiment with E.V.P. during your investigations. It is not at all difficult to 
capture these voices from the other side. It also takes very little knowledge and equipment to do 
so. There are to many investigators out there who are (or feel) intimidated by this phenomenon. 
Many do not take the time to research or educate themselves or their group(s) on the subject. 
This is one reason why I choose to volunteer my time and services to anyone who wants to 
learn about this field. I will not go into that right now because this isn’t an article about ME but 
for YOU, the investigator, to perhaps learn from and use for your future investigations. I will 
try and touch on a brief history, some current theories about this topic, a few tips to help you on 
your way and still throw my own two cents in.  
  

Thomas Edison was the first to look into electronic voice phenomena in the early 
1920’s. After his mother had been sick for some time (and was on death’s door) he decided to 
try and find a way to communicate with her after she passed. Shortly after he started work his 
mother did pass on, leaving Thomas with a more urgent need to find a way to communicate 
with her. After the planning phase, he began construction on a device with his assistant Dr. 
Miller Hutchison, which was later to be called the TEC (Thomas Edison Communicator). 
Edison didn’t get to complete his work before his own death in 1931. But since that time it has 
been completed by others using his notes and is being experimented with today.  This device is 
basically like a giant microphone for the dead. It seems to be able to pick out their voices from 
the air.  Very little is known about how this device actually works. Such groups as the 
International Ghost Hunters Society have been able to use it though and claim to have good 
results.  These may be available to the market soon but I am sure they will not come cheap.  
One could only hope that Mr. Edison is very proud that his invention was finally completed. 
Even though it is to bad that he wasn’t able to use it to communicate with his mother as he had 
intended.   

Perhaps my favorite E.V.P. mentor was the now deceased Swedish film producer, 
Friedrich Juergenson.  He captured the phenomena without even knowing it while trying to 
record bird songs.  This was an accident that changed the paranormal arena forever. When 
Juergenson played the birds songs back he discovered that he had recorded voices from the 
other side. Phrases such as, “bird voices in the night” and even his own mother (who was then 
already deceased) contacted him by saying, “Friedrich, you are being watched”, “Friedel, my 
little Friedel. Can you hear me?”  This of course amazed as well as relieved Juergenson. He 
then began a recording frenzy to try and get in touch with his mother and all other spirits.  He 
died in 1964, but not before he had contacted and confirmed life after death. He was given the 



title posthumously of, “The Father of  E.V.P.”  
I am sure you are asking yourself, “Ok, so what is E.V.P.?”  Well I really wish the 

answer were so simple and easy to explain. Of course, then it wouldn’t be called the 
“unknown”. Let me first tell you that there are quite a few theories on how the phenomenon 
actually occurs.  Some believe that the spirit itself simply walks up to the microphone or 
recording device and “speaks” into it.  I personally find this very hard to believe.  How could a 
spirit that is made of pure energy (as far as we know) simply speak without vocal cords?  The 
theory that I tend to go with is that the spirit somehow imprints its “magnetic image” onto the 
recording device.  Now there are some that believe that a “residual” effect that takes place when 
some of the energy that is stored in the area of the known haunting is released.  This is very 
possible and I feel that such objects like limestone can hold this kind of energy for long periods 
of time. I also think that if you are at the right place at the right time you may just capture some 
voices of the past.  The Catacombs located in Paris, France are a great example of how this may 
occur.  There are thousands of corpses located beneath the Paris streets and they are far from 
being at rest.  This energy could very well be stored in the actual catacombs walls (made of 
limestone) themselves. Residual energy, by the way, is spirit energy that is constantly replaying 
itself over time and not an interactive ghost. Another popular theory is the spirit will speak to us 
using telepathy or use our own voice and resources to break the communication barrier from 
their world to ours.  After you have experimented with electronic voice phenomena and gained 
more knowledge and experience with it, then perhaps you can come up with your own opinions 
on the matter.  The key is to not be afraid or intimidated by them but to respect and learn from 
them.  

Secondly, E.V.P. can be captured in a few different ways. There is no right or wrong 
way to do it.  Numerous groups and investigators claim that their way is the best, or the only 
way, to capture E.V.P. I have found that this is completely incorrect though.  If there were an 
“expert” in this field then we could all put our equipment away because it would no longer be 
considered the unknown. No one knows all of the answers and those that claim they do need to 
find another line of work, or take this one more seriously.  You can use a standard cassette or 
digital recording device, but in my opinion, it is hard to compare with the ancient and bulky 
Reel-to-Reel recorder.  This recorder is what started it all and it has its good and bad points.  I 
don’t want to get too technical here, so if you would like to read more about the Reel-to-Reel 
recorder you can do a simple search for it on the Internet. When I go on investigations I choose 
to use both the cassette and digital recorder, as I feel they both back each other up.  I will 
caution that you should be sure to use an external microphone with your cassette recorder 
though. Not to help hear the spirit better, but to reduce the possibility of wheel noise generated 
by the recorders internal parts.  I personally do not use a microphone with my digital recorder 
because I feel that the internal mechanisms are not loud enough to disrupt the recording. You 
may feel differently and choose to use one if you wish.  I have received numerous questions 
asking what kind of tapes I buy for my cassette recorder.  Well the answer is, try them all. If 
you plan on or know how to use audio editing software then this really doesn’t matter.  Some 
feel that the metal content in the tape helps and it is very possible that it may, but for those of us 
on a strict budget this could get quite costly.  I have heard some outstanding E.V.P. captured on 
“Dollar Store” brand cassette tapes, so that was proof enough for me.  Sure you have the 
background hiss with these tapes but this can be reduced and cleaned with software (if used).    

 In closing, if you use some common sense and some general knowledge of electronic 
voice phenomena then you should have no problem capturing your own E.V.P.  I do hope this 
helps some of you out there and I cannot stress enough for all of you to give it a try. 



Equipment Needed For E.V.P. 
  
  
  

The equipment used for capturing E.V.P. is the backbone for how well you will do. 
There are many types and brands of gear out there to use. I will go over some of the basics here 
and give you a standard list as well as projected prices for these items.  
  

 • 1/8
th

” Patch Cord (mono or stereo) *Stereo Preferred (~ $6.00 at Radio Shack)  
 • 8 or 16 bit sound card (16 bit recommended) *standard on most computers (~ $30.00 

for standard card)  
 • Line in Jack (located on sound card in-between the speaker and microphone jack)  
 • Digital or Cassette Recorder (these range from $15-80 dollars)  
 • Cassette tapes (Low or High bias) *High bias preferred (~ $2-6 dollars at Wal-Mart)  
 • Microphones (Internal/External ranging from $10-100 dollars)  
 • Computer Software (Adobe Audition Preferred) ~ $400 dollars www.dowload.com  

(search for Audio Editing Software)  
 
  
  
Patch Cord - A patch cord is a device that is used to transfer your audio data from your 
recording device to your computer.  These can be purchased in either mono or stereo types and 
are commonly found at electronic supply stores.  
  
  
Sound Card- This device is either located “onboard” your computer or it can be purchased 
separately as a PCI card and installed on your systems Motherboard.  I would recommend using 
a 16 bit sound card and Sound Blaster © makes a fairly affordable one that will fit your need’s.  
  
  
Line in Jack- This is the input “Jack” located on your computers sound card (if available) in-
between your speaker jack and microphone jack (Usually the middle “Jack”) this is where the 
Patch cord will be plugged in.  
  
  
Digital Recorders- These recorders are very common in the paranormal field and are great for 
saving money on cassette tapes.  They do have both pros and cons though.  
  
  
Cassette Recorders- This is a great way for a beginner to learn the ropes (so to speak). They 
yield some great results when used correctly.  The good thing about these recorders is that you 
have your evidence backed up on cassette and some feel that cassette E.V.P. are much more 
creditable.  
  
Cassette Tapes- These can be found at pretty much every department store out there and there 
are two types that are commonly used for recording E.V.P.  
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Low Bias: These are a cheaper form of cassette tape and tend to produce a lot of background 
hiss due to their low metal content.  
  
High Bias: These are the closest you can get to CD quality with a cassette. This type is also the 
recommended type for E.V.P. recording.  The brand that I use is called the Sony CD IT.  
  
  
Microphone- This is considered a “must have”. There are two types that may be used.  
  
Internal: These are found on both digital and cassette recorders.  I would not recommend using 
the internal microphone on the cassette recorder, due to the fact that they capture the internal 
wheel noise of the machine and create false positives.  I find that the internal microphones on 
most digital recorders are sufficient though. I have had little to no problems using just the 
internal microphones on them.  
  
External: These may be purchased separately or come with your recorder.  These should be 
used with all cassette recorders and be placed as far away from the recorder as possible to 
eliminate mechanical noise.  
  
  
Computer Software- This is a touchy subject for most investigators in two ways.  One, a lot of 
them use this software incorrectly and ruin a lot of really good E.V.P. The actual software is 
pretty basic to use but intimidates a lot of people. (We will go over this more in the advanced 
lessons.)  Two, a lot of investigators choose not to use editing software for their recordings 
because they say it altars the E.V.P. itself.  This is true for some but if you know how to use the 
software properly then this should not be a problem.  I prefer to use either Adobe Audition or 
Sony Sound Forge.  There are many different types of sound editing programs available. You 
can read their details and options to find what is best for you.  If you are watching your budget 
(like most of us are) I would recommend starting out with Accustica or Gold Wave. After you 
have mastered the basic editing software you can work your way up to the more detailed 
software.  
  
  
  

 
 
 
 
 
 



Methods For Capturing E.V.P. 
  
  
  

There are a few ways to capture your E.V.P. and these are just a few that I have tried 
with success.  There are many experiments that are ongoing as we speak and I will keep you 
posted on any new breakthroughs.   
  
Question & Answer Method - This is one of the most popular methods used by 
investigators and it is a great way to interact with the ghost or spirit you are trying to contact.  
Normally this is done in what are called “sessions”. Sessions consist of recording in 3 to 5 
minute segments and then listening (I suggest bringing a set of headphones to the site with you 
for better listening) to what you have recorded to see if their questions have been answered in 
some way.  Sometimes the spirit will give you a brief response to your question just as others 
may choose not to speak at all.  I perform my sessions by designating an investigator to do the 
majority of the speaking and then others may ask a question as directed by that main 
investigator. It is a good idea to have all members of your group talk at some point during the 
recording so that their voices are on the tape for possible comparison later. You can really 
interact with the spirits using this method and you may be able to find some great information 
once you learn how to listen.  The main key to remember when using this method is RESPECT. 
Do not demand anything from the spirits as this will really damper your results (I learned this 
early on). Remain as courteous as possible while performing these sessions to get the most out 
of them. Please do not over use the word “dead”. A lot of these ghosts or spirits do not know 
that they are no longer living and this can really upset or shock them. Speak to them as you 
would speak to your friend or a stranger you meet for the first time. I have found this to yield 
the best results. Always thank them for their time when you are done. I will go over some of the 
best questions to ask in another lesson but the above description should get you started on 
understanding this method.  
  
Stationary Method - This method has been around for quite some time now and has proven 
itself to be very effective in some investigations.  This method is ideal for picking up residual 
activity in a known haunting.  The process is quite simple to perform and allows you to do other 
tasks while the recorder is doing its job.  I would recommend using a cassette recorder for this 
method due to the external microphone being able to pick up a larger area of sound. Most of 
your cassette recorders already come with an AC adapter to save you on your batteries as well, 
but please be sure to ask the client if you may use their electricity before you do this, it is just 
common courtesy.  To begin you can simply place your recorder in the central area of the room 
and press record. Make sure to start out each recording session by stating the date, time, 
temperature (inside and/or outside if they are known) and location.  Here is a tip I learned 
through experience if you are doing this while there are a lot of other people in the area.  You 
can place baby powder around the area of your recorder to let you know if anyone other then 
yourself has tampered with your evidence.  I know this may sound extreme, but trust me, this 
has been done in the past and it is best to know that what you record is as authentic as possible.  
You can leave your recorder running for whatever amount of time you desire. Do keep in mind 
though that the longer the recording session, the more you have to upload and process through 



your computer.  I would recommend stopping every 10 minutes and then restarting the tape to 
cut down on your segment processing time.  
  
  
Walking Method - Some investigators choose to use this method. I have found it to be more 
difficult to obtain credible evidence using this particular one however.  The walking method is 
performed by leaving your recording device set to record while you are in motion, be it in a 
cemetery or other location.  I find that this method generates a lot of false positives due to the 
fact that so much extra noise gets recorded while you move.  You really have to pay attention 
and try to verbally note everything that is going on around you onto the recorder. Examples of 
what to listen for would be a dog barking, someone talking, twig snapping (loud enough that 
you heard it), note when you are walking up stairs, opening doors and so on.  This will reduce 
possible errors when processing the recording.  Try not to make sudden movements either, as 
these will cause the microphone to either rub against your clothing or just make a static type 
sound on the recorder.  If you follow some basic guidelines and use common sense, then you 
should have no trouble with this method of recording. Sometimes this is the best choice, 
depending on circumstances.   
   
 
 
 

What Questions To Ask 
  

  
  

There are many different questions that you may choose to ask during an E.V.P. session. 
If you find, or already have some, that you feel are getting good results then please share them 
with others so that we can all gain from the experience.    

Try to start your session by explaining to the ghost or spirit (out loud) what exactly you 
are trying to accomplish.  You want to explain to them how the device you are using is able to 
capture their voice or image and how the process works when you play it back. It may help to 
actually point to the microphone while explaining how it works so that they can try and direct 
any comments in that direction. You want to also ask, not tell them, to speak as clear and loud 
as possible so you might be able to hear them better. Allow about 10-30 seconds between each 
question before another is asked to give the spirit ample time to answer you.  Please try to 
verbally note all background sounds that you may here while recording so that you will not 
mistake them for actual E.V.P. when processing your recordings later.      

  
 
 
 
 
 
 
 



 
Here are a few questions that are commonly used by investigators during a Q & A 

session:    
  
  
Is there anyone here that would like to talk to us?  
  
Can you tell us your name?  
  
How old are you?  
  
Why are you here?  
  
Are you sad or angry?  
  
Are you alone?  
  
How many of you are here?  
  
What is your favorite color?  
  
Can you tell us what happened to you?  
  
Can you see us?  
  
What do we look like?  
  
What color is your hair?  
  
Do you know my name?  
  
Would you like us to leave?  
  
Is there any way that we can help you?  
  
Can you show us what you look like?  
  
Is someone keeping you here?  
    
Do you have anything to tell us?  
  



  
  

Be sure to end your recording by letting the spirit(s) know that you are now going to 
listen to your recording. Let them know that if you hear anything from them you will return to 
communicate with them further (only if that is the truth of course). Make sure you thank them 
for their time and be sure to say goodbye at the end of your recording while allowing a wait for 
a possible response.  I have had a lot of spirits tell me goodbye. It is a great way to end your 
conversation with them.   We try not to use the word “Dead” in our recording sessions as this 
may offend the entity or send them into some kind of shock as there are several they may not 
yet realize they are no longer living.  This of course is just our opinion but we are there to 
research just how they are able to communicate, not if they are dead or not as we should already 
know this. 
  
  
  
  
  

7 Rules for Group Recording Sessions 
  
  

The following rules should be followed to ensure the validity and accuracy of any anomalies 
discovered during playback.  

  
  

Rules for group Recording:  
  

 1. It is very difficult to remember a specific incident or phrase after hours of recording. 
Because of this you should write down things as they happen. One person should be 
designated as the one to write down every sound other than you talking. Examples 
include, but are not limited to: someone walking, cough, dog barking, siren, twig snap, 
rustle of someone’s clothing. Basically anything that you can hear.  

 
  

 2. Everyone should speak in their normal voice and refrain from making any unusual 
sounds; including whistling, whispering, loud chewing of gum, etc. Try not to laugh or 
speak in case the voices begin to speak while you are speaking.  

 
  

 3. Other equipment that makes any noise while working should not be used during a 
recording session. Silent equipment may be used, but no talking should be done about 
the readings until after the recorder is off. Be aware of any sounds your equipment 
makes. If your camera is silent, but clicks for every picture (all make some sound) then 
it is not silent and should not be used during a recording session.  

 
  

  



 4. Have each person record a baseline of his or her name. They should state their name 
along with a few additional words. This way you will be able to distinguish the human 
voices from spirit voices when you process your recording.  

 
  

 5. If anyone makes an unusual noise, he should clearly state to the recorder his name 
and the type of sound, ex. “Todd sneezing”.  

 
  

 6. Try to eliminate multiple conversations as this complicates listening for E.V.P. during 
playback.  

 
  

 7. Conduct 3-5 minute question and answer sessions where everyone at the investigation 
site is in the same place. Questions are asked one at a time with an appropriate period 
between questions to allow for the spirits to answer.  

 
   
  

Best Times For Capturing E.V.P. 
  
  

Many people think that there is a perfect time to capture an E.V.P. In actuality you can 
capture them pretty much anytime or anywhere.  You don’t have to wait for a “full moon” or 
until it gets “dark”.  These are all Hollywood hypes created by people who are out for the 
cinematic look, not facts.    

For instance, you can go to a cemetery during the day and capture an E.V.P. just as 
easily as you could at night. A lot of these cemeteries have what is called a dusk to dawn law 
though and you must obey this rule out of respect for both the community and the dead.  If you 
were to go to the same cemeteries during the day, you could do all of the recordings you want, 
without breaking any laws.    

Now don’t get me wrong here, I do believe that the moon and the sun play a big part in 
the paranormal world’s magnetic fields. I am just saying that they are not a necessity to go by. 
Investigators tend to do a lot of their research at night due to the dark background (as it 
improves the quality of photos and video) but it doesn’t affect the recording process at that 
time.  Are there better times to try your luck? Yes, there are. A lot of investigators like to wait 
until the “witching hour”.  This is from 9pm – 3am, with the most effective being the 3am hour. 
The reason for this is still unknown, but some researches think it is due to the “veil” separating 
the physical and the paranormal world being at its thinnest. You could also keep an eye on solar 
activity. Solar storms are known to change the electro magnetic field of the earth. This is why 
you will see a solar activity monitor on many paranormal sites (I have one on mine as well 
www.hauntedvoices.com ). I already said that a full moon doesn’t necessarily help on 
investigations. But a New moon (or up to three days after) might. Another factor is the 
immediate local weather. Of course, I do need to give credit to Hollywood for getting the basic 
idea of a thunderstorm starting activity, to be correct. Please don’t read this as a good idea to go 
out in a downpour with metal equipment and try to do an investigation. I said that Hollywood 
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got the basic idea. By that I mean that a thunderstorm does indeed change the magnetic field 
around where they are occurring. Common sense is required is all. Keep in mind that a 
thunderstorm changes the field before and after it passes to, so you really don’t need to be doing 
anything during a downpour.   

Now that you know a few examples of how your environment can affect your 
investigations and your E.V.P. Any combination of the above should help as well. Experiment 
with going out under different conditions and see what you can come up with. Remember there 
are no experts in this field and we are still experimenting with a lot of these theories.  I will be 
going through some of these topics in more detail with the advanced lessons but this should get 
you started on your way to communicating with the other side.  

  
 
 
 
 
 
 

White Noise 
  
  

With the blockbuster movie that came out in January of 2005, the term white noise was 
viewed in a different light from what paranormal investigators actually use it for. White noise, 
to a paranormal investigator, is a type of sound that is produced by combining a lot of different 
frequencies together. If you took all of the imaginable tones that a human can hear and 
combined them together, you would have white noise.  

The description "white" describes this type of noise in the same way it describes white 
light. The word “white” is used because the color white is created when all the colors in the 
light spectrum combine. A prism can be used to separate white light back into its component 
colors. White noise (also called white sound) is a combination of equal amounts of different 
frequencies of sound, just like white light is a combination of colors. You can think of white 
noise as 20,000 tones all playing at the same time and at the same level.   

Because white noise contains so many frequencies, it is often used to mask other 
sounds. If you are in a motel and voices from the room next-door are leaking into your room, 
you might turn on the fan to drown out the voices. The fan produces a good approximation of 
white noise. Why does that work? Why does white noise drown out voices?   

An example of how white noise works with the brain is this: Say you just parked your 
car at a mall with your two friends in the back seat and your cell phone rings. You pick it up 
and start talking. While you are talking to the person on the phone one of your friends in the car 
starts asking you a question. Normally you would either stop listening to the person on the 
phone for a minute, or you would hold up your hand and ask the person in the car to wait. Why 
do we do this? It is because the human brain can actually only listen, process and understand 
one voice at a time. If you were to stay on the hypothetical phone and two others in the car start 
talking to each other, you would “hear” them all, but you could only listen to one at a time. 
Now if we were to step this up to explaining white noise, let’s have the three people in the car 
walk into the mall. You are still on your cell phone and the other two are still talking. But as 
you enter the mall even they tend to be drowned out. There are simply too many people talking 



at once. Even if you were to get off of the phone and just sit in say…the food court of the mall. 
All the noise is hitting you, but you can only pick out one conversation to listen to at a time. 
When we go back to the motel scenario we can now understand why the fan drowns out the 
voices coming through the wall. The fan would be the mall noise, while the voices next door 
would be the two other people in the car as you enter the mall. They are simply lost in the other 
noise.  

White noise is controversially thought to attract spirits. I say controversially, because it 
totally depends on which investigator you talk to about it, for what their view is on the subject. 
Some do not choose to use white noise due to the background it creates for the recording or 
they think that it masks over the actual E.V.P. Others swear by it, while still others only use it 
sometimes. For the same reason some dislike the use of white noise, others like it. That being 
that one of the positive things when using white noise is that it gives you a constant background 
noise. This helps to make your recording more credible if you do capture an E.V.P., as it makes 
it harder to fake one while keeping the background noise unbroken. But I’m getting ahead of 
myself now. I’m sure your wondering how white noise is used and why. Right? Well, this is 
where fact of what it is starts to blur with why it is used, as white noise in relation to the 
paranormal is all theory. Just like everything else in the paranormal field is.  
 White noise is used as a “base” for recording during E.V.P. sessions. When it is used it should 
be played at a very low “hum” in the background. One of the leading theories in relation to the 
use of white noise is that it “attracts” spirits, therefore getting more E.V.P. I have heard of more 
than one person/group who has tried this and then swears they will never go without it. You 
may also want to play this in the background while you conduct your investigations. Some feel 
this helps keep the spirit interested as well as makes it easier for them to communicate with 
you. I recommend you experiment with this process and try different approaches. Find what 
works for you.  

You can either purchase a White Noise CD (We provide several noise disks at Haunted 
Voices) or you can make your own by simply downloading a tone generator. One good one is 
the E.V.P. maker or the NCH tone generator (both are listed in the download section of our 
website www.hauntedvoices.com ) and recording the sound to a disk your self.    
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Introduction to Adobe Audition 
  
  

A Adobe Audition is a great piece of equipment for the serious researcher. This software 
was formally named Cool Edit/Cool Edit Pro 2.0. Adobe acquired the company and made some 
great improvements to the program.  Haunted Voices is currently working with Adobe to create 
a program that is focused on the paranormal community and I will keep you up to date on the 
progress. The following information is some of the basics behind operating the program and 
learning how to process your recordings. I will break these down for you in a step-by-step 
process. Please be sure to read through all of the steps before beginning to edit or upload your 
recordings and please look for our Advanced Introduction to Adobe Audition coming soon.  For 
more information or questions please feel free to email us at info@hauntedvoices.com        
    
    

How to upload recordings to your computer using Adobe Audition 
    

For this process you will need what is called a audio cable or “Patch Cord”. These can 
be purchased at your local electronics store or in the electronic department of your local 
merchandiser.  Some will vary in length but be sure it is 1/8” in size and a “Shielded” cord is 
preferred to help eliminate RF interference.   
    
Step 1:  INSTALLATION – First you will need to ready your computer to accept audio from 
your line in jack and this can be done by clicking on the Yellow or Grey volume horn that is 
located next to your computers clock.  After this is double clicked, it will open your volume 
properties and the following will work for must integrated or “build in” sound cards.   Once 
your volume properties are open you will need to click on Options located in the upper left 
corner and then Properties.  With the Properties area open, be sure that you click on the 
Recording selection and are sure that your Line In box is selected.  After this is selected then 
press ok and you will now see it added to your volume properties.  Now slide the volume level 
bar on the Line In volume setting to 4 notches below maximum.  Click on the X to close your 
volume control panel and you are now ready to except audio from your line in jack.  Plug one 
end of the patch cord into the “Ear/Headphone Jack” of your recording device and plug the 
opposite end into the “line in” jack of your computers sound card. This is how most uploads 
will be done. If you have any questions please feel free to email me.    
    
Step 2:  SETTINGS - Open the Adobe Audition software and click on File then New. This will 
bring you to the Waveform settings option.  For your sample rate you should select between 
44150 or 48000 Samples/Second (the higher the number the more space that will be taken up 
on your hard drive if saved and much better quality).  Next you will want to select Stereo or 
Mono as this will be your personal choice but please remember to have a true stereo recording; 
you will either need to separate microphones or special equipment.  For training purposes lets 
just us the Mono setting.  For your resolution you can choose 16bit for most recordings or if 
you have a high-end sound card you can choose the 32bit but keep in mind if you share this 
with others in a 24 or 32 bit format that their sound cards may not be able to hear this quality if 
not compatible.  After above is done, press OK.    
    



  
Step 3:  UPLOADING - Now that you have your software ready for recording, it is time to 
upload your data and record it to your computer.  Some investigators choose to just upload the 
segment that they wish to process but I usually upload the entire recording and then remove any 
negative excess later due to the fact that it uses excessive space.  This is not true with Adobe 
Audition as it uploads using a cache or temp system, which does not save the uploaded segment 
to your hard drive until you save it manually.      
    
    

For Cassette Recorders 
    

 • Press the pause button and the play button to preload your cassette recorder.     
 • point the mouse cursor over the record button of Adobe Auditions Transport Control 

section (little red button in lower left corner).     
 • With one finger on the pause button and the other on the left mouse button, press and 

release the two simultaneously. This will begin your recording/uploading process to the 
program.  

  
If you have a full 30 minutes recorded on your cassette do not fear uploading it.  This will 

work just fine and not consume space on your hard drive.  It is saved in a temp folder.  I 
have even uploaded full cassette tapes and walked away and listened to them later but be 
sure to check on the upload from time to time.      

    
   
*BE SURE YOUR LINE IN FEATURE IS SELECTED* this can be done by clicking on your 
volume horn located by the clock. You can look to see if this is muted or not.      
You may need to click on the properties then on the advanced tab to see some of these features.  
Click on options then properties and select “Recording” make sure the “Line In” option is 
selected in this feature.      
    
    

For Digital Recorders 
    

The process is pretty much the same for the digital recorder except you would just press 
play on the device when you are ready to record. There have been some issues with using the 
USB option that comes with the newest models of digital recorders. I personally choose not to 
use this option for a couple of reasons. One reason is that the USB option, in my opinion, 
cannot decipher the sound as well as the computers sound card can and may result in a lower 
quality recording. This is due to its “high compression” features so you can upload hours of 
data in a few minutes, thus reducing quality.  Reason number two is that there is more work for 
your computers processor and components involved with using this option and if you are in the 
field and do not have your computer with you, you have to bring the software drivers that came 
with your recorder and install them on another computer if you wish to analyze them on site.    

  With the patch cord you can upload them very easily to any computer and NO software 
or drivers are needed. Be forewarned that some models will automatically upload in mono if 
you use a Patch Cord. This would be normal for some newer models because the computer chip 



inside is only designed to decipher mono from stereo when using the program that is included 
with it.  You can always change the recording to stereo with Adobe later if need be.    
    
    
Step 4:  AMPLIFYING - This process can be used if you feel you have captured an E.V.P. and 
wish to enhance the sound for better processing.      
    

 • Click on the Effects option located at the top of the program.    
 • point the mouse cursor on Amplitude.    
 • Click on Amplify/Fade.      

    
  

This will bring you to a Presets menu.  Keep in mind that a little goes a long way in this 
program.  I usually start with a 3db (Decibel) boost and then replay the recording. You can 
apply a further boost of 3db – 10db as needed.  *DO NOT OVER AMPLIFY YOUR 
RECORDING* this can greatly reduce the sound quality and possibly damage your data. If you 
feel you over amplified your recording just click on edit and use the Undo feature to take you 
back before the amplification was applied.  

  
Some recorders may even need to be adjusted for DC offset which can unbalance the upload 

and lower the quality of your recording.  An “off center” white line in the middle of your wave 
form would indicate this problem but it is easily remedied.  Just right click over your Level 
Meter and put a check mark next to Adjust for DC and your problem will be repaired.  Once 
this setting is activated, you will not have to set for adjustment again.  
    
Step 5:  CLEANING - This process seems to be the most difficult for investigators to 
understand and I will try my best to explain it.  If you wish to go over this section “hands on” 
then please contact us for a private lesson at training@hauntedvoices.com        

This process will differ between cassette and digital recordings due to the “hiss” (also 
referred to as a form of white noise) generated by cassettes.  You can either break down your 
segments or clean them (explained further with private lessons) or you can clean your entire 
recording (this may take several minutes to complete).  I usually clean my entire recording 
because you never know what may be missed or hidden in it once it has been cleaned.      
    

 • Click on the Effects tab once again.     
 • Point the cursor over Filters    
 • Click on Scientific Filter    
 • In your Presets box locate Hiss Cut Above 10 kHz    
 • Click on this option and then press OK    

    
   

  
  
  
    
 
  



  
This will filter out a small amount of the hiss and target hiss about 10 KHz or 10,000Hz 

(Where loudest distortions are usually located). Be sure to listen to the entire segment after the 
reduction has been made.      

If you wish to continue making small hiss cuts use this feature.  If your recording has heavy 
background noise (usually cassettes) then I would recommend using the Hiss Reduction 
option.      
    

 • Click on Effects    
 • Hover mouse cursor over Noise Reduction    
 • Click on Hiss Reduction    
 • This will open your settings box.    

    
   
  
  
 *Please read the following very carefully*    
This is where a lot of people tend to ruin or distort their recordings, so please read before doing 
anything.     
    
In the Settings box you will see a graph of your recording and a box of Presets.  The Light 
Hiss Reduction preset is usually the only one that you will be using.      
    

 • Click on the Light Hiss Reduction preset to highlight it. You will see your graph flat line 
(this is normal).     

 • Click on Get Noise Floor and this will quickly adjust your recording and load its current 
noise floor onto the graph.      

 • Press OK and the light hiss reduction will be made.      
    
   

When you listen to your segment after making this adjustment and you may need to make 
another reduction.  If too many of these hiss reductions are made, your recording will sound 
extremely digitalized and the E.V.P. will be unsuitable for evidence. I would recommend using 
only the Scientific Filter for your reductions unless you have heavy background hiss.    
    

 Removing Clicks and Pops 
    

This is a nice feature that Adobe Audition has. It is also an asset for those of us who still 
use cassettes for recording. This filter will repair what is needed and reject what is not, so it is a 
pretty safe filter to use.      
    

 • Click on Effects    
 • Hover over Noise Reduction     
 • Click on Click/Pop Eliminator (Avoid using the Automatic option *Adobe Audition 

version 1.5 & 2.0 only)      
 • In the Preset options click and highlight your desired filter, usually the Hiss + Lots of 

Clicks filter and click OK   



    
  
This process may take several minutes to complete with a longer recording.  You should 

hear a significant difference after using this filter.  When you become more experienced with 
the software then you can read our next training guide to learn how to use the Fill Single Click 
Now feature.   
    
   
Step 6:  REVERSE OPTION - This is a feature that can be used to see if your E.V.P. has a 
“Reverse Meaning”.  ALL E.V.P. should be reversed to see if you have captured two different 
words or phrases.  There have been several E.V.P. that have been captured that say one thing 
forward and something completely different in reverse.  The reason that some spirits do this is 
unknown but it is a pretty common occurrence.  To reverse you’re E.V.P.:    
    

 • Highlight the area you wish to reverse    
 • Click on Effects    
 • Then click Reverse  
  
*Note* don’t not listen to these files to much or Loop them!  You will do what is called 

Matrixing and begin to hear what you want to hear.  I listen to these files for no 
longer then 30 second intervals.    Reverse speech is NOT back masking or human 
mind trick (in my opinion) and should be experimented with to further its validity.   

    
  Step 7:  ENHANCING SOUND – If you are planning to upload or share our evidence with 
others on the Internet, I would recommend using this next feature.      
    

 • Click on Effects    
 • Then Filters    
 • Select Graphic Equalizer    
 • Click on the tab that says 30 Bands 1/3 Octave    
 • You will see numerous presets at the bottom. I usually use the one titled Destination 

Home Theater select this filter.     
 • Click OK     

    
   
This will improve the sound quality on some of your E.V.P.  This does not alter your evidence 
but merely enhances it.  If you prefer to save your Evp evidence for internet sharing then it may 
be best to convert it to an Mp3 format.  You can do this by click on file then save as and be sure 
to select Mp3Pro from the drop down menu that is provided for you.     
   
Special note – ALWAYS Edit your file in .wav or “Raw” formats to ensure the best quality of 
your recording.  
  
  

 
 
 



 

 
Adobe Audition  

Advanced Training Guide 
 
 

I have been asked by hundreds of others to write a more advanced training guide to 
Adobe Audition and due to this high demand and because I value each and everyone one of our 
members. I have decided to take some time and write this up for you.  I really do wish that I 
could promote this heavy and even publish it as I did the first training guide, but I must be 
careful because SEVERAL individuals have taken my work and claimed it as their own.  Please 
don’t get me wrong here because I don’t mind sharing in the least bit, but some will take full 
advantage of this.  This to me is very sad and all they had to do was ask permission and give 
credit where it was due, and I would have no problem sharing this with everyone!  Now I am 
not bragging here and saying I am the best around but I must be doing something right if people 
steal my hard work, don’t you think? Thank you very much for your compliments and support 
on our first Introduction Training Guide and with this new Training Guide you will learn many 
more features!  I do hope you find this very useful and gain even more out of your Evp research 
just as I have learned.  I have worked with this program for several years and would like to 
share all of the information that I have learned with all of you but keep in mind that I can’t tell 
everything I know, as this wouldn’t be right and make us all unique like we are so please 
understand that I do keep quite a few techniques to myself for my own protection.  For more 
information or questions please feel free to email us at   info@hauntedvoices.com   or visit our 
website www.hauntedvoices.com        
    
    

Advanced Cleaning and Analyzing Features 
    

For several years I have been processing Evp recordings of all types, sizes, classes, and 
qualities and these are just a few of the filters and other processes I have used to create the best 
clarity and quality as possible.  There are several researchers that do not agree with my methods 
or even the fact that I use software at times to enhance my Evp.  I do not ask that all of you 
agree with my methods but do ask that you at least take the time to read and try them for 
yourself, as I feel there are NO EXPERTS or a right or wrong way to do this and any feedback 
is much appreciated.  In this section I will introduce you to some new features as well as 
advanced techniques and explain them in a step by step format as best as possible.  Please note 
that this training guide is intended for advanced users only and you should practice with the 
techniques described to you in my previous Adobe Audition Introduction before attempting to 
utilize these techniques.   
    
   
   
         
Lesson 1:  Converting Sample Type – This is a feature that I use very often and it will increase 
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the quality of audio recordings from most IC (Integrated Circuit) recorders as well as analog 
devices.  A Sample Rate is the actual sound samples played per second.  Basically, the higher 
the sample rate then the higher the sound quality.  Example 44,000 = CD quality, 48,000 = 
DAT (Digital Audio Tape quality, 96,000 = DVD Quality, and so on.  I prefer to use a sample 
rate of 48000 unless I have access to a higher production sound card.  To convert the sample 
rate of your recording (Which should be done at the beginning after upload and is “Simulated 
quality if your sound card isn’t capable of producing these samples) Follow this instructions 
and keep in mind that most IC (Integrated Circuit) recorders upload on a average 22000 
Samples/sec, with some as low as 8,000 smpl’s/sec, so it may be necessary to Up Sample your 
recording. Let us discuss this a bit as to why it may be necessary to up sample.  With all of the 
different recording devices that we use, they all have their own quality.  Due to this I like to 
make the entire sound file that I work with, the same quality.  This really helps me with the 
analysis aspect as well as improves the Evp itself.  Different devices capture at different Hertz 
levels and by being consistent with an up sample, you may have better luck determining the 
actual Hz level of the Evp itself.   
   

 1. Choose Edit > Convert Sample Type.    
 2. Select a rate from the Sample Rate list 48000 recommended, or enter a custom rate in the 

text box.    
 3. Drag the Low/High Quality slider to adjust the quality of the sampling conversion. I 

usually drag this all the way to the right for maximum.   
 5. Click OK to apply your up sample (This Process may take a few minutes depending on 

your computers processor and size of file uploaded.   
     
    
Lesson 2:  Hiss Reduction Preview – In my first guide I went over the standard or preset 
options for the Hiss Reduction filter.  I would like to introduce you to the High & Low floors as 
well as the preview feature.  The hiss reduction filter is a Very powerful tool that can be 
misused very easily and can cause massive over correction to your file if not used properly.  For 
this purpose it is much easier to use the Preview feature to apply changes to your file in real 
time and actually hear the effect results before the filter is applied.  This is a very simple 
procedure and with some practice you will have this down in no time.  To activate the Preview 
feature in the Hiss Reduction filter area, simply click on the Preview button located in the 
upper right corner.  This will loop your entire recording or highlighted portion, which allows 
you to hear the effect in real time.  Depending on the clarity or how much hiss you would like 
to remove, it would help you to choose what reduction preset to apply.  I normally use the light 
hiss reduction filter as it seems to work best with most recordings without removing too much 
of the hiss itself (I feel most Evp are actually embedded in this background hiss and need it to 
come through more clear).  After you have selected your desired hiss reduction level, then you 
will need to capture the noise floor of the desired section needing reduced.  To do this, simply 
click the Get Noise Floor button and at that time press the Preview button to begin your 
reduction.  By default, the program will use a noise floor adjustment level of about -1 to -3db or 
Decibels.  This can be adjusted manually by sliding the Noise Floor Adjust bar to a desired 
reduction level.  Be very careful of this manual adjustment because a little bit will go a long 
way here and can distort your Evp by making it sound “Metallic or Robotic”.   Use this at your 
discretion and experiment with the Noise Floor Adjust bar until you get your desired hiss 
reduction that you would like.  *Please Note*  The manual adjust speed is based on your 



computers processor speed and may take a few seconds to adjust to the new settings you 
provided so please be patient and wait to hear a change in the effect before applying further 
adjustments.   
   
Lesson 3:  Fill Single Click Now Option – This is a great new feature added to Adobe Audition 
1.5 and 2.0 that allows the researcher to remove unwanted noises or “bloopers” in the actual 
recording.  This will make a more professional Evp as well as eliminating such things as Wind, 
chair squeaks, cursing, over talk, large pops, and insects.  I have used this feature many times 
myself and find it as a very useful tool and very easy to use.  Please do not abuse this feature 
and only use it when needed.  Of course it is always best to keep your Evp in its “Natural” state, 
but there are times where this just isn’t possible and buy using this feature you can correct these 
errors very easily and with no damage at all to your captured Evp.   To use this feature please 
follow the steps below:   
   
You must highlight the desired area that you would like removed prior to moving on from 
this point.  Be sure to highlight “A Single Click” or small size areas to obtain the best quality.   
   

 1. Click Effects>Noise Reduction>Click/Pop Eliminator.    
 2.  Look in the lower left corner and be sure that your FFT (Fast Fourier Transform) is on 

auto.   
 3. Click on the Fill Single Click Now button located on the bottom center and your filter will 

take effect automatically.   
  
   
After this filter is applied be sure to listen to your file and the background noise or section you 
wanted removed, will be removed and replaced with the average or “natural” noise of your file 
and you will not be able to tell that it was even their to begin with!   
   
    
Lesson 4:  Noise Reduction Filter – We explained this powerful feature briefly in our previous 
Adobe introduction, but I would like to take it to a more advanced level for you.  The Noise 
Reduction filter is a VERY powerful tool and can be an asset to some of your Evp captures.  
The Noise Reduction effect dramatically reduces background and broadband noise with a 
minimal reduction in signal quality. This effect can remove a wide range of noise, including 
tape hiss, microphone background noise, Mild RF Interference and more.  The proper amount 
of noise reduction depends upon the type of background noise and the acceptable loss in quality 
for the remaining recording.  So, to apply a proper noise reduction you will need to Highlight a 
quiet or mild background portion of the file or “white noise” (Without vocals preferred) and 
then follow the steps below to apply it to your desired section or Evp.   
    
 1. Right Click on Highlighted file portion and select Capture Noise Profile.  *Note* if using 

Auto FFT setting (Recommended) You will need to highlight at least 1.5 seconds of audio to 
capture noise profile.   

 2. Click Effects>Noise Reduction>Noise Reduction (You will see your profile in display graph).   
 3. Click Preview (located near lower right corner).   
 4. Adjust your Noise Floor Level by using the slider bar.  Be sure to exercise caution in this area 

as adjusting the floor to high will result in severe distortion of audio.     



 5. Continue Noise Floor Level adjustments as needed until the desired sound is obtained and 
then click Ok to apply filter to file.   

   
    
Lesson 5:  Spectral View – The Spectral View is a view that many of you have seen or 
experimented with in the past, but we are going to properly introduce you to it in this section.  
This view is by far one of the most popular views that I tend to use with the program and we 
will go into a bit of it throughout this section.  This view lets you analyze your Evp audio data 
to see which frequencies are most present. The greater a signal's amplitude component within a 
specific frequency range, the brighter the displayed color. Colors range from dark blue 
(meaning that the frequencies are very low in amplitude) to bright yellow (meaning that the 
frequencies are high in amplitude).  This color system can really help us determine several 
things about the Evp itself, For example; is it in the normal human vocal range?, Is it consistent 
with other Evp frequency ranges within the file?, and so on.  This will be shown in Hz or 
(Hertz), which is a frequency term to measure sound or a related frequency.  You can use your 
Vertical Scale or “Hz Ruler” to determine an estimated Hz level range of the file.  Keep in 
mind that normal human hearing range is from 20Hz to 20,000Hz and the human vocal band 
,(Usually light Yellow on Spectral View), will range from 1,000 Hz (loud whisper) to 4,000 Hz 
(normal speech),(This may differ with recording devices and human vocals themselves).  By 
seeing the actual frequency display you can actually see the “sound” itself which is quite 
amazing.   
   
  In time you will even be able to recognize some Evp without even hearing them due to their 
misplacement and frequency ranges.  I have even captured Evp that appeared in the 22,000Hz 
level range which is far above normal human hearing and also called Ultra Sound.  By using 
the Spectral View you can even select specific areas to clean or enhance your Evp by using the 
Marque Selection Tool.   To use this tool you will need to click on the dotted line square 
located on the shortcut bar, or simply hit the M hotkey located on your computers keyboard.  I 
highly suggest you experiment with this selection tool and please let me know your feedback.  I 
would also like to add here that some of you may not be able to see the standard colors of the 
Spectral View due to your programs default theme setting.  Let’s go over how to change your 
theme in Adobe Audition so you can not only see these spectral colors but also find a theme 
that may be better suited for you.  To change you programs theme, click on Options>Settings> 
and then select the Colors tab.  Now you will see your current theme displayed in the box on 
the right side.  To switch to a new theme, click on the drop down arrow under Color Presets 
and select your desired theme (I use Midnight Blues or Stealth) and then click Ok to apply your 
new theme.   
   
I hope this give you a little better knowledge on the Spectral View Feature and I do suggest that 
you use this view as much as possible so you can get the “feel” of working with frequencies in 
more detail.  Although this views frequency/Hz measurement isn’t 100% accurate as far as Evp 
are concerned, it is a great asset to us for comparing Evp frequency in relation to normal human 
frequency placement. We will be going over more detailed ways to measure frequencies in the 
Frequency Analysis feature.   
  
Lesson 6:  White Noise Generator– Adobe Audition has a great feature included with the 
program that can generate Pink, Brown, and White Noises for Evp Enhancement.  White noise 



can be a very effective tool in the field if you are at an area with low activity or are capturing 
“Faint” or less Evp.  There are also other things that researchers have used for background 
noise, for instance, Radio or Television static seems to be popular as well as fans, various tones, 
foreign languages, and even reversed human vocals.  All of these items may be very effective if 
used properly but please keep in mind that when using other vocals, you may actually “matrix” 
and think you have an actual Evp and really don’t at all.  Just keep in mind that background 
noise, no matter what it is, is a tool and should be used properly and ALL surrounding sounds if 
heard should be noted to eliminate false positives.  The theory of “White Noise” dates back 
several years and has been used by many researchers.  These researchers claim to have better 
results in certain locations by using it then not using it at all.  White Noise contains several 
frequencies in a variety of different bands that just may help the “spirit” speak or increase its 
“vibration” so I recommend that you at least give it a try before you just simply rule it out.    
Please use this noise as a tool and not a “crutch” in the field and keep in mind that results will 
vary and may not be the same for each individual.  Some feel this noise doesn’t work at all but I 
feel in this field we have to try all we can over and over until someday the final answer is 
brought to us, so you be YOUR OWN judge on this and don’t rule it out until YOU have at 
least given it a few attempts yourself.  Creating white noise with Adobe Audition is very simple 
and you can make as much as you want when you want and create your own CD’s and 
Formula’s to experiment with.  Please follow the steps below to begin creating your own 
background noise.    
   
 1. Click on Generate>Noise   
 2. Select desired noise (White recommended but experiment with each)   
 3. Select Mono(Spatial Stereo if compatible)   
 4. Select Intensity Level using slider bar.  (I personally use 27 – 28    
 5. Type in your duration time (in Seconds) 60 = 1 minute 4000= over 1 Hour   
 6. Click Ok   

    
Please allow extra time for the white noise to be created as this may take server minutes with 
large duration times.   
   
Now that your Noise is generated, you can do one of two things.  First you can loop the noise to 
play endlessly on your computer if you have access to one in the field.  Second, you can now 
make a copy of this or “burn” it to a CD to take with you in the field and be played on CD 
media compatible players.  You can either use a third party burning software like Nero or Roxio 
or you can use Adobe Audition for this as well!  Yes, it even comes with its own burning 
program.  To use Adobe Auditions burning program just click on the Cd Project View Tab and 
Drag & Drop your completed noise file into the burning area.  Click the “burning Cd Icon 
located in the shortcut bar, tile your disk and you’re ready!     
If you are burning a disk to be played on an Mp3 compatible player (Requires less space on 
compact disk) then you will need to save your file as an Mp3 prior to burning it.  If you would 
like to create an Audio Cd then I would keep it in .wav format and choose the Make Audio Disk 
feature that is included with most third party burning programs (takes more space on disk) and 
you will be able to play this in most CD media devices if you choose to use this method rather 

n a computer.   the     
  
Lesson 7:  Frequency Analysis Box – The Frequency Analysis box is one of my favorite 
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features to use and perhaps one of the most difficult to learn as well as for me to Instruct.  I will 
do my best to explain this to you but keep in mind that it takes several months to perfect this to 
where you feel comfortable with your results.  The results brought forth from this analysis ARE 
NOT  100% accurate and Haunted Voices is working with Adobe Audition as beta testers (We 
currently have 3 on staff) to implement better features for this area.  Haunted Voices is still in 
the experimental phase with this feature but this is what we use for our submitted Evp analysis 
requests and ask that you follow the below instructions carefully and check for frequent updates 
to this section on our website as our research techniques progress.   
   
To activate the Frequency Analysis you will need to click on Analyze (located in top row of 
menu keys) and click Show Frequency Analysis or you can use the hot key method of ALT+Z 
to get the box to appear.  When done correctly, a small box containing a graph will appear in 
the center of the program.  To use this analysis correctly, this window must be “Docked” or 
locked into place in the program.  To “Dock” the Frequency Analysis box, you will need to 
place your mouse cursor over the box “header” or top of box and then press your left mouse 
button and while holding the button down, drag this box down to the bottom center of the 
program.  You will see the box disappear and then see a glowing horizontal line running across 
the bottom of the program.  When you see this glowing line then release the left mouse button 
and your frequency box should appear in the lower left corner.  If you analysis box is still not in 
place then repeat the process as necessary.    
   
Now that your Frequency Analysis Box is in place, let’s go over some of the controls 
associated with it.  For instance, you will see a box in the upper left corner that says Liner 
View, be sure that this box is Unchecked because we are looking for a logarithmic scale which 
will give you the maximum range of the frequency and keeping its resolution clear.  The Liner 
View, if selected will provide long and narrow horizontal lines which are more difficult to pin 
point specific frequencies if using the Hold Feature which we will explain shortly.  With the 
linear view unchecked, now we are all set to start our analysis!  First, you need to practice 
watching this frequency analysis box while playing your recording.  By doing this you will get 
use to seeing it perform in what is called a Dynamic View meaning it is analyzing the entire 
recording while the clip is playing.  You also have the Static View (what we use to analyze 
Evp) which occurs when you select a desired potion of the clip, for example the Evp itself, and 
then scan this into the frequency analysis box.  To scan and analyze your Evp into the 
frequency analysis box please do the following:   
   
   
   
   
   
   
   
 
 
 
 1. Highlight a specific section of file (Your Evp)   
 2. Click on the Scan Button located on the lower right corner of the frequency analysis box.   
 3. Click on the Loop button (Looks like an infinity symbol)    



 4. While file is playing Hover mouse cursor over first “peak” of file, working from left (low end) 
to right (High End).   

 5. Compare your Hz levels (located in lower left corner) and the initial Hz reading from the 
first Evp vocal peak will be the Estimated Hz level where the Evp may have been captured 
at.   

 6. You can also use the Hold buttons number 1, 2, 3, and 4 to “freeze” a desired frequency for 
easier measurement.  This takes much practice but with a good set of eyes and ears you 
should have no problem getting down to an art.   

  
   
This will take quite some time to practice and is very difficult to write or teach over phone so I 
do hope this helps and we will keep you up to date on any changes with this feature.   
   
   
This will conclude this Advanced Training Guide and be sure to stay tuned for Adobe Audition 
102 Training Guide that will come to you in Late 2006 that will include features and techniques 
for Adobe Audition 2.0!     
   

I would also like to add that for even more help and information please contact our Research & 
Development Direct Jeremy Pippin and look for his Training Guides on Cool Edit/Cool Edit Pro 
& Gold Wave.  To contact our Research & Development Department either visit our website or 
email us at research@hauntedvoices.com 
 

 
 
 
 
 
 
 
 
 
 

Classifying Your E.V.P. 
 



Since its discovery in the early 1950’s, Electronic Voice Phenomenon or (Evp) has been widely 
studied by paranormal researchers from around the globe.  We have all been fascinated as well as 
confused by our findings and are constantly searching for more answers to our questions.  With 
today’s technology, which is growing at a very rapid rate, we sometimes become engulfed in its 
possible capabilities.  This technology has both helped and hurt us, causing some researchers to 
miss the “big picture” and focus more on quantity then quality of our Evp.   
 
Sure, being “up to date” has its advantages but we must ask ourselves this:  “Did past researchers 
need this to capture the phenomenon?”  The answer is simply, no, they did not.  Some of the 
best Evp that I have ever heard came from what we call “Old School” recording devices such as 
Reel to Reel or analog recorders.  These devises are what the phenomenon was discovered with, 
so why do we not use them now?  The answer to that would be technology.   With new recording 
devices and computers, this older equipment has almost become obsolete!  In the lessons, we 
provide at Haunted Voices, I have instructed hundreds of people on the basics of Electronic 
Voice Phenomena, and some of them have never even heard of an analog recording device.  So 
just how serious are today’s Evp researchers?  Trust me they are very serious, however, with all of 
the “hype” and publicity that Evp has gathered over the past few years many of them are left in 
the dark. It seems that no one has taken the time to explain to them either the basis of Evp or 
how it was discovered. 
 
Some look at paranormal research as a hobby or something to do when we have the time but I 
assure you that those of us who do this on a full time basis find this quite shocking. Most of us will 
jump at the chance and take the time to explain it to those in need.  This is somewhat of a silent 
oath we took and something that we feel we owe to our fellow researchers.  It doesn’t take very 
long at all to spread the word about it and shed some light on the past Evp Pioneers. Trust me, 
those you enlighten will thank you for it in the end.  A collogue of mine, Jeremy Pippin woke me 
up to this and I would not only like to thank him for doing so, but hope it helps some of you.   
 
For a moment now, let’s talk about the Quality verses Quantity issue.  As researchers, we need to 
work as a whole in order to achieve this goal. There are far to many “Territorial” individuals out 
there who feel it is their way or no way and that they will single handedly solve the mystery.  This 
folks, has to be one of the most ridiculous claims I have ever heard of! I personally feel this will 
be a group effort and not a single endeavor. 
 
With a higher Quality of EVP, comes not only reassurance of life after death, but also a 
reassurance to its existence at all.  I have processed thousands of “so called” Evp and have heard 
everything from the recording of a television program to a screaming coffee maker!  Now, how do 
you think the general public sees this?  I promise you, they are laughing in our faces. People, 
these EVP’s are not hidden, these are everywhere on the World Wide Web!  As researchers, we 
have to take this very seriously and can’t just blow it off thinking, “Well I didn’t record it so it 
doesn’t affect me”. Oh, it most certainly does! So, lets all do what we can to prevent this virus 
from spreading; educate these individuals, DO NOT make fun of them!  
 
 
EVP quantity seems to be the goal and focus for many groups and websites out there. This has 
gotten way out of hand and really needs to be addressed by someone.  If I hear one more person 
say, “Well, we have more Evp on our site then they do”, I’m going to be sick.  Is there some kind 



of Oscar award given for this that I’m not aware of?  People seem to be getting so caught up in 
the latest craze that they are missing the point and looking at the paranormal as a competition and 
not research.  Peers and critics do not judge you by how many you have captured, but instead, by 
the Quality of those you have obtained. Quality is the key word here people, and to obtain and 
realize this Quality you must be educated. You can’t just fly by the seat of your pants!  
 
There are several organizations, which are devoted to Evp education; Haunted Voices, American 
Association of Electronic Voice Phenomena (AAEVP) and the International Ghost Hunters 
Society just to name a few.  So, take the time to look them up, find one that best suits you, and by 
all means, educate yourself. These groups have made the mistakes and learned from them so you 
don’t have to.  
 
Some of you may have taken offense to the above statements while others will support them.  As 
I tend to voice my opinion and often have little regard for the controversy that follows. My way of 
thinking is what makes me a unique individual.  I take full responsibility for the above statements 
and urge you to submit your comments and concerns to me personally. 
 
With that said let us get back on track here. We have all used the classification system but do we 
really know how it works?  This infamous system was developed by my very close friend and 
mentor, Sarah Estep, has been used by all of us to classify our Evp files.  I am talking about the A, 
B, and C filing system.  This method of classification makes it easy, and has created a universal 
method, for analyzing our Evp. It is immediately recognized and still used to this day!   
 
 
Now let’s get to the heart of this article and talk about Classification.  Lets first start with the Class 
A Evp.  A Class A Evp is one that is very audible and can be clearly understood without the use 
of computer or software intervention.  These classifications, as well as the next two were 
developed by Sarah Estep to simplify our recordings.  At Haunted Voices, we like to have our 
Evp files confirmed by 2 or more individuals before classifying them as an A.  This helps to 
ensure their authenticity as well as their quality.   Class A Evp are very rare, and although I have 
captured the majority of them on analog recorders, I have captured a few on the digital as well.  
To hear one of these classes, is unmistakable, and you should be able to do so without the use of 
headphones and straight from the recording device itself.  Try not to mistake these for 
background noise or talking as this is one of the biggest traps for “false positives”.  While in a 
recording session, be aware of your surroundings and try to note as many natural sounds as you 
can.  As a rule, if you can hear it, note it!  This will eliminate many of us scratching our heads 
later.  Once all of this has been eliminated and you can identify the voice as authentic and not 
background, then and only then should you begin your classification process.  
 
 I have captured the majority of my Class A Evp by using the common Stationary Method where 
you simply set the recorder in a desired area and leave it to do its job.  I have also captured them 
by using the Question & Answer method and this is a great way to help prove human and spirit 
interaction.  You decide which method is best for you. Make this decision on your own and try 
not to be influenced by others.  As long as you hold the education and are aware of each method 
available, then you are more then ready to make your own judgment and build your own 
recording foundation. 
 



Class B Evp recordings are somewhat similar to a Class A but are not clearly heard by all.  These 
recordings are usually mixed messages or jumbled words that the researcher can not clearly make 
out.  These are not always at a lower capture volume and are sometimes just as audible or even 
more audible then a Class A.  These seem to be the second most common Evp capture and 
although some can be cleaned or enhanced with software intervention, once a Class B always a 
Class B no matter how clear it becomes.  You simply can not change the classification just 
because you weaseled your way into making it clear. The original capture value needs to be 
respected.  Sure, its fine to post it saying it was cleaned or enhanced but be sure to let them know 
that it required your assistance to make it legible; don’t change the classification just to suit your 
needs or reputation.  
 
Class B captures can be some of the most frustrating little files you have ever encountered, but 
then again, everyone enjoys a good challenge don’t they?  No one clearly knows or understands 
why some of the words are jumbled or inaudible but this could be due to background 
interference, dimensional barriers, recorder or microphone quality, or just plain signal 
interruption.  Personally, I have captured the majority of my Class B files using the digital 
recorder during the Question & Answer method. Although  I really enjoy the challenge of these 
files, and hope you do as well, please feel free to contact our Evp analysis department  should you 
become too frustrated or just want some simple clarification. We will be more then happy to 
assist you in any way possible. 
 
Class C Evp captures are, by far, one of the most common. These files are mostly inaudible or 
very low whispers and usually require software intervention. Many researchers simply “toss” these 
aside, or even delete them entirely and I like to call this “Spirit Prejudice”.  These files are just as 
important as the rest and should be treated with just as much respect.  If you were talking to an 
audience and opened the floor for questions, but couldn’t hear the question from the person in 
the back of the room, what would you do?  You would either ask them to speak louder or go to 
that person directly.  You wouldn’t just ignore them, would you?  Well this is the same concept. 
Some of these Class C Evp’s can be enhanced enough to make sense, however others just can’t 
be helped. These files, however, should be kept on file because as we talked about before, 
technology is creeping up on us and who knows what the road ahead will bring us!   
 
There are several programs out there with a wide variety of features to help you enhance or 
process Evp files but please don’t overuse them, or use them as a crutch.  These are simple tools 
and should be treated as such. Use them wisely.  At Haunted Voices we offer advanced lessons 
specifically for this purpose. And although we use and recommend © Adobe Audition,  this is 
not for everyone; it is expensive and not in every person’s budget.  I have also used programs like 
wavepad © and Gold Wave © that can be great tools. Through available demo’s you will find 
what works best for you and your budget. Remember, on the website, help is just a click away  if 
you need it. 
 
The Class X Evp is a new classification created by Haunted Voices and means Reverse or 
“Unknown”.  Reverse meanings contained in Evp have been around since the discovery of Evp 
but not quite researched or grasped until Hypnotherapist David John Oates discovered it in 1983 
by finding reverse meanings in human speech.  This seems to apply with Evp as well and although 
some claim it has no merit, I am a firm believer in its existence. To this day, I continue to 
research it further.  For example, you may have captured a Class A Evp with a forward meaning 



of, “Can you help me?”, but when this is reversed using software, you may hear a hidden meaning 
such as, “Cross over”, or “To the light”. 
 
Basically, the spirit is using a double statement somehow and actually saying two separate 
messages in one Evp.  These meanings although rare, have occurred, and I was quite skeptical 
about them myself until it happened to me personally.  Some of these Class X reversals do sound 
like “gibberish” or “garbled” and some feel it is all in our heads, but can they say for sure?  No, 
they sure can’t and that is what keeps us battling for the truth of the phenomena and why we 
should respect it more then we do.  To me, reverse meanings in an Evp are not demonic, back 
masking, or subliminal occurrences, but something that simply can not be explained.   
 
Could this be a dimensional flip? Possible frequency change or just timing? No one knows why 
this occurs and that is what makes is so intriguing to us.  So, do not judge a person by their beliefs, 
as this is not the answer. In fact, all you will find in doing so is the loss of a possible friendship.  
To find out even more about reverse speech I strongly recommend you visit David’s website at 
www.reversespeech.com and make your own judgments. 
 
In closing, we all have our own theories and methods for capturing Evp. None of them are “set in 
stone”, they are our opinions gathered from experience, results, and overall communication with 
others.  Be your own judge and before you step out the door to start recording, don’t just hit the 

record button and sit there and tap your foot; prepare yourself with education.  In this field, 
knowledge is power and power is the key to unlock the answers we are all looking for.  Last, but 
not least, please remember the pioneers that made this fantastic phenomenon known to us all. 
Respect their research and findings, and use them, as they are not broke just forgotten and lost 

with today’s fast growing technology.  As the old saying goes “If it ain’t broke, don’t fix it”; simple 
words for a powerful meaning. 

 
 
 
 
 
 
 
 
 

http://www.reversespeech.com/


Investigation Equipment  
  
  

Let’s go over some of the basic and advanced equipment and how it may be 
used for investigating paranormal activity.  
  
  
  

Basic Equipment  
  
  
Notebook or Journal:  This is a key piece of equipment for the investigator and 
should be used to document all activity.  This may also be used for the interview 
process and mapping out of the area.  
  
Flashlight: These are very common now and you can purchase one just about 
anywhere.  Most researches have now advanced to the LED flashlights due to the 
larger coverage area they provide.  They are a little more expensive but are worth 
the extra money. There are many different varieties out there, ranging from $10 
on up into the hundreds. It is up to you what you are looking for.  
  
35mm Camera: For the most part these are no longer used that often but I 
personally still use them.  Be sure to use 400 to 800 speed film (800 preferred for 
low light conditions).   
  
Digital Camera: These are by far the most common camera out there and vary in 
pixel ranges.  I prefer to go no higher then 3.2 mega pixel due to the fact that 
higher mega pixel tend to “over correct” some anomalies that we are attempting to 
capture.  
  
Cassette Recorder: These can be found at your locale department store and are 
still used for capturing Electronic Voice Phenomena.  Most have switched to the 
digital recorder due to their convenience but I feel the cassette recorder provides 
much stronger evidence.  
  
Cassette Tapes: There are several different brands out there and I personally use a 
“High Bias” cassette tape made by Sony.  You can use other brands and biases but 



“High Bias” is preferred for CD quality evidence.  
  
Digital Recorders: These little recorders have made some great improvements 
over the years and if programmed on the right settings, can capture some great 
evidence.  Be sure to set them on High Quality (HQ) and either have the 
microphone sensitivity on “High” or have it on the Conference setting (depending 
on the make and model of the recorder). Never set your digital recorder on voice 
activation for an investigation as some E.V.P. are simply not strong enough to 
activate the recorder.  
  
Memory Cards: Let’s face it, we take a lot of photos during an investigation and 
most digital cameras only have a 16MB internal memory card.  It is worth the 
extra money to invest in an external memory card for your camera or a higher MB 
internal.  
  
Microphones: An external microphone should be used while using the cassette 
recorder to eliminate “internal gear noise” that may be generated during the 
recording.  An “Omni directional” (all sides) microphone is preferred for better 
quality but a “Unidirectional” (one direction) microphone will work as well.   
  
Two Way Radios: These are inexpensive and are a great communication tool 
while on location as well as a safety requirement for most research groups.  
  

  
  

Advanced Equipment  
  
  
Laptop Computer: These are great for processing evidence on location and can 
perform a wide variety of functions.  Be sure the laptop has USB connections, 
plus external speaker and line in jacks.  
  
Card Reader: These work in conjunction with your laptop and can read a wide 
variety of digital camera memory cards.  This will eliminate a lot of investigators 
having to bring the camera connection cords and is a much quicker process.  
These are portable and require a USB connection.  
  
Jump Drive: These will hold various amounts of data from other investigators 
such as photos and recordings. They can also be easily transferred from one 



computer to another.  
  
Recording Software: This also works in conjunction with your computer and is 
required for on location E.V.P. processing.  Adobe is preferred but there are many 
other programs that may be used.  
  
Audio Cable (Patch Cord): This 1/8” cable can be purchased at your local Radio 
Shack and should be used to upload your recording from the device to the 
computer (for more information see “Introduction to Adobe Audition” on the 
Haunted Voices website).  
  
Electromagnetic Field Meter (EMF): These are used in detecting disturbances or 
changes in magnetic fields.  The TriField Natural EM meter is preferred but other 
devices may be used.  Be sure to eliminate false positive while using other 
models, as they tend to pick up AC fields.  
  
Non-Contact Infrared Thermometer (Thermal Scanner): These provide the most 
accurate temperatures during an investigation.  They can detect a cold or hot spot 
from several feet away.  Unlike “ambient” (Room Temperature) thermometers, IR 
thermometers detect quicker and have more accurate readings in desired sections 
of the room.  
  
Video Camcorder: There are several makes and models of this piece of equipment 
and it is best to purchase one that is already equipped with “Night Shot” (able to 
record using the Infrared light spectrum).  
  
Tripod: These can be used to add extra stability for your camera.  They are very 
inexpensive and are a must when monitoring a single room or area.  
  
Infrared Extender: These may be purchased separately to enhance the night vision 
area of the camera.  Most camcorders come with a 10-foot maximum coverage 
area.  This unit can extend that to 100 feet.   
  
Motion Detectors:  These are used to detect motion of spirit activity in an area.  
They are triggered when a “mass” is within range or breaks the IR beam of the 
unit.  Some of these may also be triggered by sound or pressure drops.  
  
CCTV Monitors & Cameras: These are great for monitoring rooms when you are 
dealing with a large area.  You can find these at various locations and some prefer 
wired cameras to wireless due to the interference caused by the wireless system. I 



personally would choose the wireless do to the easier set up.  Be sure to purchase 
a system that is equipped with “night vision” as these will pick up activity on the 
Infrared spectrum.  You can purchase a single camera wireless system for about 
200 dollars.  
  
Thermal Imaging Cameras: These are actually quite pricey but are great for seeing 
temperature changes in an area.  These work by showing you a black and white or 
color (more expensive) image of actual hot and cold spots that are created when 
some spirits are using the energy in an area to manifest.  
  
Sound Enhancement Aids: These are often referred to as “bionic ears”.  I 
personally haven’t had much luck with these but some say they can actually hear 
voices with them that the normal human ear could not.  
  
Geiger Counters: These are fairly inexpensive and are used to measure radiation 
levels in an area.  Some feel that spirits emit a low-end form of radiation and this 
could be used to detect such levels.  
  
Air Ion Counters: These are used to monitor the positive and negative ions in the 
atmosphere.  They can fluctuate during storms or when paranormal activity is 
present.   
  
    

  

 
 
 
 
 
 
 
 
 

Suggestions for Professional Client Interviewing, 



Investigations and Paranormal Team Guidelines  
  

 • At some time in this field of study everyone is going to be either doing the interview, be a 
part of the team doing the interviewing, or be in the presence of the client of the location 
being investigated.  Everyone needs to be as professional as possible while in the presence 
of the client as this not only says a lot about you but also reflects back on your group.  Many 
people feel that how one acts is how you all will, be even though this may not be the case.  

 
  

 • The client has contacted you with a specific problem or something that has affected their 
family and their personal lives.  Usually the client has dealt with the situation for quite a 
while and has finally decided that the events that have been transpiring can’t be explained 
away with the every day typical reasons.  Many times the client is almost to the point of 
thinking that all the ones involved with the incidences are losing their minds or are a little 
crazy.  The interviewer needs to be reassuring, but also keep an open mind so that their 
views aren’t tainted without the proper evidence to support the client’s complaints.  

 
  

 • A good tip (or habit that should be practiced) for interviewing is to request to run a tape 
during the initial visit with the client and throughout the interview.  Many times EVP’s are 
captured through the conversations with the client and while asking the questions about the 
activities they are experiencing.  While interviewing, observe everything around you and 
take note of things that you might need to check further into during the investigation.  After 
the interview, be sure to make notes of anything you felt and/or observed so that it can be 
thoroughly examined with the investigation team.  

 
  

 • During the interview and the actual investigation always remember the client called you 
about their problems not any of the paranormal experiences the team has experienced in 
their own lives.  The only time that personal experiences should be brought up is only if the 
client explicitly asks about any similar activity or if the client needs assurance they aren’t 
the only one that has had things like this happen to them. If this is required, briefly tell them 
of past happenings for an example.  Always remember: we are there to listen to them, not 
for them to listen to our past experiences and life events.  

 
  

 • If your team has personal conflicts within the group, be a good team leader; nip it in the 
bud before you start your investigation.  The negative energy from the problem will affect 
not only your other team member’s attitude, it will affect the evidence of the investigation 
and if you are not careful (depending on the entities of the location) you could be opening 
your team and client up to danger.  Negative energy has a tendency to bring forth negative 
paranormal results.  Good team leaders will either get the problem resolved prior to the 
investigation or will select a team that doesn’t include the people with the problems.  
Negativity has no place in a professional paranormal team and it doesn’t provide a 
professional appearance for the client that you are working with/for.   

 
  

 • While on location everything that is going on in your personal life should be left outside.  



Keep your attitude light so you are open to experience whatever occurs at the site.  You are 
there to investigate the location for anything out of the ordinary but also to be objective to 
what might be causing it. This includes activity that is caused by non paranormal means.  

 
  

 • Don’t reveal anything to the client until the team can review, discuss, and determine the 
evidence that every team member collected.  The team needs to realize and accept that while 
on an investigation; yes, they took the photo; yes they took the video; yes they did the 
tapings for the EVP, but the evidence belongs to the group and to the people involved 
with the investigation, not to individuals involved in the investigation.  All evidence is 
supposed to be kept confidential within the group that did the actual investigation and the 
people the paranormal activity is affecting.  Even though you might have gotten the most 
fantastic video, photo, EVP, visited the most haunted location, etc. always remember that 
without proper information release you could be laying yourself open for a lawsuit.  The 
people involved graciously allowed the team into their lives to experience and research the 
unusual happenings they have endured. By doing so they are showing that they are trusting 
the team to keep all the information and evidence confidential within the team that was on 
site.  No one on the team should rush home and start telling and showing their evidence to 
everyone they come in contact with afterwards.  If they have a problem with their 
equipment to secure the evidence for the team then they should contact a fellow team 
member to get help, not an outside source that will have privilege to confidential 
information.  If a team member has personal problems from data and evidence they 
have collected they should never destroy it prior to turning the evidence over to the 
team leader!  All evidence should be turned in to the team leader within a few days so that 
all the evidence can be reviewed, confirmed, then complied to submit to the client and the 
people the paranormal activity is affecting.  When this isn’t done the information collected 
is not only incomplete, but also shows the team leader which ones on his or her team that he 
can depend on for future investigations to perform in a timely professional manner needed 
in all investigations that they are requested to do.  

  
 
  

 • People should realize that many that don’t believe or accept what we do scrutinize our 
field of study harshly. We need not have our own personal performances make us look 
unprofessional on top of that.  We have to always be honest with everyone on our team as 
well as the public because if we aren’t able to always be honest then how can the evidence 
we collect be accepted as legitimate and factual?  

 
  

 • There is no room in this field of study for drama. Our field of research is well known for 
how intense it can be at an active location.  The professional team members will get enough 
of a “rush” from the evidence collected from an active location without causing 
undercurrent “drama” within the members of the team.  If a team member can’t be honest, 
can’t abide by the regulations required to be a professional team member, can’t keep 
information confidential, then to keep the team a professional group and to insure that the 
integrity stays intact, the team member creating the problems should be confronted and cut 
from the team.  Though it is great when all team members can become friends, but just like 
any job, sometimes this isn’t possible.  Conflicts of personalities, beliefs, unable to follow 
professional guide lines, some that make it a practice to use others for their own gain, those 



that back stab other team members to produce drama and excitement in their lives, that 
make agreements that once have gained access to a location or information then they don’t 
adhere to their agreements, those that set up other team members with false statements and 
foremost those that only say “I” instead of “WE” or “TEAM” have no place on an elite 
professional paranormal team.  If other team members can’t accept the decision for the good 
of the team then they have the right to resign from the team because all teams have to accept 
what creates a good elite, professional, credible, and honest team that is able to work 
towards professionally collecting the most credible, scientific and never before obtained 
evidence to offer to society to confirm what we are researching.  If we can do this, then our 
team will be one that is sought out by the public to investigate on a continual basis.   

 
  

 
 

Client Interview Process  
  

Throughout this study course, you will learn many different theories 
and approaches as well as equipment use for conducting an 

investigation.  What I would first like to get into is the aspect of 
screening your clients prior to an investigation.    

  
Unfortunately, in our line of work (paranormal investigators), 

there are quite a few people out there just want to give us a call to waste 
our time for “Friday night kicks” so to speak.  Some individuals that 
call you will sound very sincere in their intentions but truly have a 
different purpose for us.  The problem is that we, as investigators, have 
to take any notification that we receive very seriously no matter how 
crazy the situation may sound.    

As an investigator, all the calls must be treated with respect and 
interest to the client.  Have them tell you what they are experiencing in 
their residence, listen and take notes on all of this. What you learn in 
the beginning will play a major role in their story when it comes to the 
interview process later.  Like I have said before, you will have some 
that just want you there for entertainment. Most of us provide a free 
service so this is cheap entertainment for quite a few people while some 
are just curious.  After you have finished listening to their situation, you 



need to set up an interview or “preliminary investigation”, to go into 
further detail about their situation. This is also a great way to see if their 
stories match up to what you already recorded.  I know this may sound 
harsh but I assure you that there are some out there that will use you. 
We all work to hard with our research for us to be used in this way.  

Before the interview process, you will need to take a few things 
with you.  You will need a recorder or notebook of some kind, a 
liability document for them to sign, paperwork to give them that has a 
detailed description as to what your intentions are and what you will be 
using as far as equipment in their residence.  I would advise bringing 
someone else to recorder data and take notes of the area while the 
interview is in progress.  Have them note the client’s moments and 
facial expressions to your questions, as these will be key as to their 
credibility.  Here are a few questions that you can ask the client during 
the interview. Always ask their permission to be recorded on tape or 
film prior to the interview. Answers to these questions can help you 
decide what are real, possible hallucinations or flat out lies.    
  
  
How long have you lived here?  
  
Describe what you have seen?  
  
Do you hear voices?  
  
Have you done any recent remodeling to the residence?  
  
Have you had any loved ones that have passed recently?  
  
How many children do you have and what ages? (Key in poltergeist 
activity.)  
  
Are you or anyone that lives in this residence taking medication of any 
kind?  If yes, what?  
  



Does anyone use alcohol?  If so, how much?  
  

  
After the interview process is complete, you and your group need 

to have the client take you around the residence and show you where 
they have experienced the most activity.  Note everything unusual in 
the area as well as where objects are placed and how the house is 
maintained.  Are the clients clean and organized?  If they are having 
objects disappear, and they appear to be organized, then this adds 
further possibilities to their credibility.    

When the preliminary investigation is complete and you have all 
of your data you will need to regroup with your team and discuss your 
true feelings of the client and what your approach is going to be.  This 
should never be discussed in the presence of the client. You may need 
to do some background research of the area and do not be shy about 
asking the homeowner if they have an abstract of the residence.  This 
will help you tremendously in research and will give you a few names 
and backgrounds as well.  You want to research the land that the 
residence or building stands on.  Just because the house may be haunted 
does not necessarily mean the haunting is tied to the house itself.  The 
haunting may be tied to the land and the homeowner may not be aware 
of this. If after this process is complete and your group as a whole feels 
that this may be a hoax, then you need to pull out of the situation as 
gracefully as possible.  This may be a very hard decision but you will 
know after the interview process and data collected if it is a possible 
hoax. It would be your call as to whether a full investigation is needed 
or not.  Try and keep in mind that this is your time and that your time is 
valuable.    

  
  

  

 
Residence Investigation   



  
It starts with a phone call, email, Instant Message or word of mouth 

generally. Someone asks you a “hypothetical” question; contacts you 
terrified or they take the “business only” approach. There are a number of 
ways for this to happen, but when it does, you as an investigator are 
intrigued immediately.  Some accounts may sound preposterous, some 
may give you chills and maybe even some have a natural explanation that 
jumps up waving a red flag in your mind. The reason behind an approach 
to investigate can be null at times. Your job is not to tell a potential client 
they are wrong from the get go. Instead, you should be considering the 
risks. Would it be safe for you and your group to enter this situation? Are 
you qualified to handle this situation, or should you contact or refer them to 
someone with more experience in the area they seem to need?  Are all 
parties involved willing to have a paranormal team intrude? And sadly, 
sometimes, it needs to be asked (in your own mind or within your group) if 
the person contacting you is sane. After asking these questions, and 
answering them in a light that shows safety for all, you can then sit down 
with you team and decide whether or not you will investigate. If a personal 
issue arises with a team member, address it. Sometimes, for one reason 
or another, a team member might not feel safe going to a destination. 
Respect this decision for the good of your team. If all is well for the rest of 
your team, then you plan your approach, contact the appropriate authority 
(generally the person who contacted you) and set a date to investigate 
that fits both your teams and the client’s schedules.  

 Several aspects should be covered prior to the investigation. You 
should explain to the client the number of people you will be bringing to 
their home (depending on size and normally no more then 5) and your 
intentions.  They need to realize you will be in their home for a long period 
(possibly overnight) and that they should conduct themselves as they 
normally would if you were not there.  This is important and may be hard 
for the client to do because of all of your equipment and procedures.  That 
is why it needs to be explained to them before the investigation.  They will 
want to observe your every move and will constantly be asking, “Did you 
get anything yet?” Expecting this in advance may help you. As long as the 
homeowners are there, your work will more than likely be interrupted from 
time to time during the investigation.  You need to stress to them that they 
must try to act as if you were not there at all unless you would call on them 
for assistance, after all they are the ones being haunted not you.  If they 
break their normal routines, you may miss certain paranormal events that 



take place.  
Once you arrive at the location you will need to conduct a standard 

walkthrough of the area and use some of the research you have gathered 
to locate some of the “hot spots” to concentrate on.  Most groups out there 
do not have that much equipment and this is why it is easier to start from 
the bottom of the residence and work your way up (if one story, then from 
the front to the back).  You should concentrate on an area and if no activity 
is noted then you simply move on to the next area.  You will want to take 
EMF and temperature readings and note any changes from room to room.  
Look for a 10 to 15 degree drops or increases in temperatures or EMF 
readings from a steady 2 to 7 miligauss.  After you have conducted your 
site readings then you need to review your notes as to where the 
differences took place and try to concentrate on these areas.    

The next step would be to set up whatever equipment your group 
uses.  Place your video monitoring equipment (if applicable, though this is 
strongly recommended) to where it can cover most of these areas.  If you 
do not have that much monitoring equipment then simply send a group of 
two people to that area and have them sit and monitor any changes in 
activity.  Most of what we do consists of waiting and this can be a very 
long process.  This is why you need to keep in contact with your group 
members to keep interest strong.  Be sure to rotate your members to 
different areas, as this can be very long and sometimes monotonous work.  
Once you have your cameras and monitoring devices (motion detectors) in 
place then simply sit back and wait. Be sure to document any activity that 
you may witness.  Observe the clients and how they are reacting and have 
them tell you immediately if they witness any strange activity.  

After monitoring for an extended period you will need to conduct a 
few “sessions”.  I like to start with recording sessions and then go to 
photos, but this is my preference.  You can conduct more then one 
recording session at a time and throughout the residence.  If this is a two-
story home then be sure to have a team located upstairs to cover that 
area.  Advise all of the team members (two-way radios work excellent) that 
you will be conducting a recording session and that everyone should be as 
quiet as possible.  If you wish, you could have your team upstairs conduct 
a recording session as well, but ONLY if their voice will not travel enough 
to interfere with your recording.  You can also use two different methods of 
recording. I have had group members downstairs conducting a question 
and answer method of recording and the group upstairs conduct a 
stationary method of recording. *  Your group leader will decide what the 
best methods are for the situation.  In a few of the recording sessions, you 



need to involve the client or homeowner and have them ask a few 
questions.  Entities may not answer you but just may speak to them.  
During most of these investigations the homeowner is looking for some 
kind of closure or explanation as to why they are being haunted and the 
answer may or may not be what they want to hear. As part of your 
responsibility, you should warn them of this prior to the recording session.  
After you have conducted a few 5-minute recording sessions, you should 
then process them as soon as possible.  I like to process mine on location 
just in case the spirits are trying to communicate and may require further 
attention.  If you fail to make communication on your first session then try 
again.  They either may not want to speak at that time or simply may not 
be there at all.  If you believe, as I do, that they can travel then this may be 
the reason.  I feel that spirits or “interactive entities” can come and go as 
they please. Where as “residual” activity is simply there and you have to 
be there at the right time to capture them on film or recording.    

The homeowner needs to know if this is a residual or interactive 
haunting.  If it is residual then they simply have to learn to live around it. If 
it is interactive then there may be a way they can live together in the 
residence and develop some kind of respect for each other.  After your 
investigation is complete, do not tell the client (at that time) if you feel the 
house may or may not be haunted or contain spirit activity.  You need to 
regroup, gather and process all evidence before a decision is warranted.  
Be sure to give your client copies of all evidence you obtain and even 
explain to them how they to can communicate with the spirits inside of 
their home.  They may just get some great evidence on their own.  The 
clients need to be educated, just as we have, on the basics of living with a 
haunting or spirit.  You will find that many clients soon become members 
of your organization. I have met some great individuals this way and they 
have been great to work with. Be sure to tell the client that if you feel it is 
necessary, you will return for further investigations.  Do not just take your 
evidence and run.  You need to keep in contact with the client, especially 
after an investigation.  Some clients experience a larger amount of activity 
after an investigation has been conducted due to us “interfering” with the 
normal routine and flow of the residence.  We have let the spirits know that 
we have been attempting communication with them and now they simply 
have to wait until we return to communicate any further.  This is why I feel 
the homeowner should be educated as they can continue what we have 
started.  

After all processes of an investigation are complete, the homeowner 
should feel more comfortable with the situation. In the rare instances of 



physical harm, be sure not to assume. As your job is to help your client 
(not make them more scared), find someone who can help them if you 
don’t know how too. Don’t take on more than you feel comfortable with. A 
lot of groups in the paranormal community like to work together. There is 
help out there, if only you look for it.  

  
  
  
  

 
  

 
 

We hope you have enjoyed our Study Guide and if you should have 
any comments or questions please email us at info@hauntedvoices.com 

or 
 

Haunted Voices 
P.O. Box 178 

Palestine, IL  62451 
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